










































































































































































































































































Figure 7 

Default button 

Buttons 

Pop-up menu 

Radio buttons 

Text box 

Check boxes 

-

-

-

(The dialog box on your screen may look a little different. It depends on the kind 
of printer that is attached to your Mac.) 

loserWriter Poge Setup 7 .1.2 nr OK ll 
Poper:_j@ US letter 0 A4 

lo us legol 0 85 l etter 0 l Tobloid ( Concel ) 

Reduce Printer Effects: Options I 
Enlorge: [gl Font Substitution? 
Orien totion [gl TeHt Smoot hing? 

[gl Grophics Smoothing? 
[gl Fost er Bitmop Print ing? 

I 
These are the most common dialog box elements and a short explanation of how 
they work: 

button Every dialog box has buttons, which start actions when you click on them. 

text box You complete text boxes by typing information at the keyboard. 

pop-up menus Pop-up menus let you select from a set of options. You dick on the 
down-facing arrow, and drag down to the option you want, the same way you use 
a pull-down menu. The currently selected option is displayed at the top of the drop 
box. 

radio button Radio buttons give you another way to select from a set of options. 
When you click on a radio button, it appears black and the other buttons in the set 
turn white. 

check box Check boxes work like radio buttons, but more than one of tl1em can be 
selected at a time. When you click on one, an X appears in the box. Click again and 
the X disappears. 

list box A list box is similar to a drop box or pull-down menu-you select from 
a list of options. But the contents of the list can change. If there are more options 
than fit in the list, the box will have a scroll bar along the right edge. 

To close the dialog box, 

7 Click on the Cancel button. 

Before you go on to the next section, 

8 Use the mouse to browse through tl1e rest of the menus. 
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Manipulating Windows 
Whether you are moving and copying files on the Desktop or creating documents 
by using application software, there is usually a window visible. All Macintosh 
windows have certain standard elements. Figure 8 shows the names of the most 
important ones. Figure 8 

.---------------------------- ----- Close box 

Title bar 
7 it~ms 66.9MB in disk 6.1 MB av 

-o L--- Zoom box 

(ru D Statusbar 

[; i!IIH~ ---------------- ::::::::: 

System Folder 

D D 
Other Users Finances Corr espondence !iii!! 

title bar Shows the name of the disk, folder, or document that is displayed in the 
window. You can move the window around the Desktop by dragging the title bar. 

status bar The status bar tells you how many items are in the folder, how much 
storage space is being used on the disk, and how much space is still available. In 
document windows, the status bar is often at the bottom of the window, and it 
contains information relevant to the program being used. 

close box Clicking on the close box closes the window. 

zoom box Clicking on the zoom box resizes the window to its optimum (best) 
size, as determined by the Finder. 

size box You can change the size of the window by dragging the size box. 

scroll arrow Clicking on a scroll arrow lets you move up or down (or left and 
right, if there is a horizontal scroll bar) through the contents of a disk, folder, 
or document. You can hold down the mouse button to keep moving in the same 
direction. 

scroll box The position of the scroll box in the scroll bar shows the relative 
position of the material that is visible in the window. To scroll up or down through 
a window, you can click in the scroll bar above or below the scroll box, or you can 
drag the scroll box to any position on the scroll bar. 

Right now, there should be one window open on the Desktop, displayed in By Icon 
view. 
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Figure 9 

While you are holding 
down the mouse button, 

only the window's outline 
appears to move. 

1 Click on the zoom box. 

The window is resized to hold all the files and folders (or as many as fit on 
the screen). 

2 Position the pointer on the window's title bar, and drag the window to 
the upper-left corner of the Desktop, as shown in Figure 9. 

3 Drag the size box up and to the left as far as it will go. 

The window is just big enough to display one file or folder. 

4 Move the pointer to the down-facing scroll arrow and hold the mouse button 
down to scroll to the bottom of the window. 

5 Drag the box in the horizontal scroll bar from the left end of the scroll bar 
to the right end. 

6 Click on the zoom box again to restore the window to its optimum size. 

7 Double-dick on the System Folder to open it. 

8 Drag the title bar of the System Folder window so it partially overlaps the 
bottom of the startup disk window, as shown in Figure 10. 
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Projects 

CJ 
Other Users Finances Correspondence 

o 
Utilities 

Notice that the title bar for the startup disk window looks different than 
before. The title is gray, and the horizontal lines on either side of the title have 
disappeared. This shows that the window is no longer active. On the Mac, only 
one window can be active at a time, and the System Folder is active right now. 

To make the startup disk window active, 

9 Click anywhere on the startup disk window. 

The startup disk window jumps to the foreground. Its title bar is black with 
horizontal lines. 

1 0 Click on the System Folder again to make it active. 

11 Click on the close box of the System Folder window to close it. 

Figure 10 

Outline of the System Folder 
window should overlap the 
startup disk window. 
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Figure 11 

New Practice folder 

Creating and Moving Folders 
When you use a computer every day, it doesn't take long before there are hundreds 
of files on the hard disk. To keep the files organized, you need to create and use 
folders. 

Right now, the startup disk is the active window. To create a new folder in it, 

1 Select New Folder from the File menu. 

A new, untitled folder appears. Before you do anything else, you should name 
the folder. To do so, you can just begin typing: 

2 Type Practice then press Return. 

The title is displayed under the folder icon, as shown in Figure 11. 

§0~ 80 MD Hord Disk ~0§ 
8 items 71 .5MB in disk 3.5 MB av 

Lll LJ CJ 
0 

System Folder Applications Pr ojects 

D 
Other Users Finances Correspondence 

3 Double-click on the Practice folder to open it. 

4 Select New Folder again from the File menu. 

5 Type Memos and press Return. 

The Memos folder is said to be nested in the Practice folder. 

To move a file, a folder, or a group of nested folders around on a disk, you simply 
drag it to its new location. For example, say you want to move the Practice folder 
(and the Memos folder nested in it) to the System Folder: 

6 Click on the startup disk folder to make it active. 

7 If necessary, use the size box to resize the window so that both the System 
Folder and the Practice folder are visible. 
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8 Drag the Practice folder to the System Folder. In other words, point to the 
Practice folder, hold down the mouse button, drag to the System Folder, and 
release the mouse button when the System Folder turns color (indicating that 
it is selected). 

The Practice folder disappears. 

9 Double-click on the System Folder to open it. 

You should now be able to find the Practice folder in the System Folder. 

Incidentally, you will often use multiple disks (such as the hard disk and a floppy 
disk) to manage your files or give files to other users. When you drag a file or folder 
from one disk to another, the Mac makes a copy of it, rather than moving it. 

Viewing Files and Folders by Name 
So far, you have been using the By Icon view, which you selected at the end of the 
second section. Many users prefer to work with this view, because the icons are 
large, easy to grab with the mouse, and easy to recognize. There are, however, 
several other views to choose from. Using the By Name option is especially popular 
because it lets you see many files at once and because you can explore an entire 
system of nested folders in one window. 

To experiment with the By Name view, you should first close all the windows, then 
reopen just the startup disk window. Here's a fast way to do it: 

1 Hold down the Option key on the keyboard and click on the close box in the 
active window. 

All the open windows close. 

2 Double-dick on the startup disk icon to open it. 

3 Select By Name in the View menu. 

4 Click on the zoom box to resize the window. 
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Figure 12 

Click on arrowheads 
to see the contents 

of folders. 

-

The startup disk window should look similar to that shown in Figure 12. 

~o- 80 MB Hard Disk 0§ 
7 items 71 .7MB in disk 3.3MB ............................................................................................ 

Name 

~ 0 Applications ~ 
~ 0 Correspondence 

~ 0 Finances 

~ 0 Other Users 

~ 0 Projects 

~ 0 System Folder 

~ 0 Utilities ~ 
¢1 _1¢ 121 

The information displayed to the right of each file and folder name in your 
window may be different than that shown here. 

Exploring Nested Folders in a Single Window 

Notice that each folder has an arrowhead, or triangle, next to it. The arrowheads 
are pointing towards the folders. To see the contents of a folder without opening 
a new window, you can click on the arrowhead next to it. For example, to see the 
contents of the System Folder, 

5 Click on the arrowhead next to the System Folder. 

The arrowhead turns down to tell you that the contents are displayed. The contents 
of the folder are indented below the folder. 

6 If necessary, scroll down to find the Practice folder in the System Folder. 

7 Click on the arrowhead next to the Practice folder. 

The Memos folder appears below the Practice folder. 

8 Click on the arrowhead to the left of the Memos folder. 

Notice that the arrowhead turns down, but no new files or folders appear 
(see Figure 13). This is because the Memos folder is empty. 
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[> D Applications 
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[> D Other Users 

[> D Projects 

Figure 13 
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D Apple File Exchange Folder 

D Appl~ Menu Items 
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D Control Panels 
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D FileMaker Temp 

Cl Finder 

Cl Note Pad File 
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To close open folders in By Name view, simply click on the arrowhead again. 
For example, 

9 Click on the arrowhead nex't to the Memos folder. 

1 0 Click on the arrowhead next to the Practice folder. 

Using the Trash 

I don't want you to make any permanent changes to the System Folder, so let's get 
rid of the Practice and Memos folders. To erase the Practice folder (and the Memos 
folder in it), 

11 Drag the Practice folder from the System Folder window to the Trash. 

The Trash is highHghted (changes color) when you have dragged the folder to the 
right place. When you release the mouse button, the Trash gets fatter to let you 
know that it has something in it. Actually, dragging files and folders to the Trash 
doesn't really delete them. They still exist, but only in the Trash: 

12 Double-dick on the Trash to open it. 

the folder to which they belong. 
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A Trash window appears, as shown in Figure 14. 

Figure 14 
Trash 

LJ 
Practice 

Trash window - --11--

To erase the folders from the disk, you need to empty the Trash. However, you 
should complete this step only if the Practice folder is the only thing visible in 
the Trash. If there are any other items (placed there by other users), skip step 14. 

13 Select Empty Trash from the Special menu. 

14 Click on the close box on the Trash window. 

By the way, you don't have to open the Trash window to empty the Trash. 

15 Click on the arrowhead next to the System Folder to rude its contents. 

The Apple, Help, and Application Menus 
You may have noticed that three of the items in the menu bar are icons rather than 
words. In this section, I'll give you a short tour of these three menus, which are 
called the Apple menu, the Help menu, and the Application menu. 

The Apple Menu 

The Apple menu, at the far left of the menu bar, contains a list of tools that you can 
use any time the Mac is running, even if you are already using application software. 
Take a minute to look at the menu: 

1 Move the pointer to the Apple icon and hold down the mouse button. You 
should see the menu shown in Figure 15. 
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Rbout This Macintosh ... 

~ Rlarm Cloclc 

~ Rpple File EHchange 
~ Calculator 

~Chooser 
G£1 Control Panels 

~Key Caps 
6J Note Pad 
~Puzzle 
~ Scrapboolc 

Some of the tools shown in your Apple menu may be a little different than the ones 
in mine, because it's possible to customize the contents of this menu. But several of 
our tools are probably the same. One handy tool is the Alarm Clock. 

2 Select Alarm Clock from the Apple menu. 

3 If the Alarm Clock looks like Figure 16a, click on the lever to the left of the 
time, to display the expanded Alarm Clock, shown in Figure 16b. 

Figure 15 

Figure 16a 

0 4:00:49 PM o-1-----------------------, Small Alarm Clock 

L Click here to expand 

The three different icons at the bottom of the Alarm Clock let you set the time, the 
date, and the time the alarm will go off. Do not change the time or date, unless 
they are incorrect. 

The Application Menu 

The icon at the far right side of the menu bar changes, depending on which 
program is currently active. You may have noticed that it looked like a compact 
Mac when you first turned on the computer. The Mac icon is displayed when the 
Desktop is active. Now it looks like a clock, because the Alarm Clock is the active 
program. 

Figure 16b 

Expanded Alarm Clock 

Click here to shrink 
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Figure 17 

4 Move the pointer to the Alarm Clock icon in the menu bar and hold the mouse 
button down. You should see the menu shown in Figure 17. 

Hide Rlarm Clock 
Hide Others 
Show All 

./ ~ Rlarm Clock 
(Q Finder 

To switch to any currently loaded program, you can either click on the application 
itself (if it is visible) or select it in the Application menu. You can also use the 
Application menu to hide programs without qui tting them. 

5 Select Hide Others from the Application menu. 

The only program still visible is the Alarm Clock. 

You will find the Application menu is extremely handy when you are working 
with multiple applications, such as a word processor and a spreadsheet. 

The Help Menu 

If you ever get stuck and need help, try consulting the Help menu first. In System 
7, the Help menu icon looks like a cartoon dialog bubble with a question mark 
in it. 

No matter what you are doing on a Mac with System 7, there are usually two 
different help features available. The first is Balloon Help, which lets you find out 
about different screen features simply by pointing at them. To see how it works, 

6 Select Show Balloons from the Help menu. 

7 Use the mouse to point to different parts of the Alarm Clock and find out 
how they work. 

8 When you are through learning about the Alarm Clock, select Hide Balloons 
from the Help menu. 

Most applications contain help systems that you can access through the Help 
menu. The exact name of the Help option depends on the application. The 
Desktop is also accompanied by a Help feature. To see it, 

9 Select Finder from the Application menu. 

10 Select Finder Shortcuts from the Help menu. 
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The Finder Shortcuts are a set of five windows that help you use the Desktop 
(Finder) more quickly with the help of the keyboard. You navigate through the five 
windows by clicking on the Previous or Next buttons at the bottom of each screen. 
Go ahead and read through the screens now. You'll find some handy tips there. 
When you are done, 

11 Click on the close box. 

Turning Off the Macintosh 
When you are through working with the Mac, your instructor or lab assistant may 
want you to turn the machine off (some schools leave their computers on; check to 
see what you are supposed to do). There's a correct way to turn off a Mac. First, if 
you have been working with application software, you should be sure to save your 
work. If you forget, don't worry-the Mac will automatically ask you if you want 
to save before you quit any program or shut down the computer. Still, saving your 
work often is a good habit. 

Next, to turn off the Mac (if your instructor or lab assistant hasn't asked you to 
leave it on), 

1 Select Shut Down in the Special menu (see Figure 18). 

Clean Up Window 
Empty Trash ... 

Eject IJislc 3€ E 
Erase Oislc ... 

Restart 
Shut Down l.r 

Selecting Shut Down lets the Mac complete any tasks it is currently working on 
and close down in an orderly fashion. The process will take a couple of seconds. 
The screen will then go blank, or you will see a message telling you that it's okay 
to turn off the power switch. If the screen goes blank, remember to turn off the 
monitor. If you see the message, click the power switch to OFF. 

Figure 18 
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Knowing the Facts 

1 Where do you click the mouse pointer 

to close a window? 

2 Which disk icon is displayed near the 

upper-right comer of the screen, 

immediately below the application 

menu? 

3 Describe the process of deleting a file 

or folder from a disk. 

4 Which mouse technique is used to see 

the contents of a disk or folder? 

5 · How is it possible to see a system of 

nested folders within a single window? 

6 How can you tell that a menu option will 

activate a dialog box? 

7 Which folder stores the operating 

system files? 

8 Say you are looking at a folder window, 

but not all the contents of the folder fit 

in tbe window. How can you change the 

folder window to see more of the 

folder's contents? 

9 Which menu option should you choose 

when you want to tum off the Mac? 

1 0 Without opening the Trash window, 

how can you tell if the Trash has 

something in it? 
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Chapter Exercises 
Using Your Skills 

The following hands-on exercises give you practice with the new Mac 
skills you have learned and direct you to some other features that were 
not covered in the Introduction. You need to use a Mac to complete 
them. 

A With the Finder active, select About This Macintosh from the 
Apple menu. Use the window that is displayed to answer the 
following questions: 
1 What model Macintosh are you using? 
2 What is the version number of the System Software that is 

loaded on the machine? 
3 How much built-in memory is in the computer? The memory 

is measured in KB (kilobytes), which stands for thousands of 
bytes. One byte can represent a single text character, so 1KB 
can represent about 1,000 text characters. 

B Open the startup disk window. The window's status bar should 
show how much storage space is currently being taken up by 
programs and documents (if this information isn't displayed in 
the status bar, see question G). The storage space is measured in 
MB (megabytes), which stands for about 1,000 KB or about 
1,000,000 bytes. 
1 How much storage is currently being used on the startup 

disk? 
2 How much storage is still available? 
3 How many items are there in the startup disk window? 

C Open the startup disk window and make sure it is displayed in 
By Name view. Click on the size box to optimize the size of the 
window. Select Show Balloons from the Help menu. Use the 
Balloon Help feature to find out the meaning of the information 
that is displayed to the right of each file and folder in the window. 
What information is given about each ftle and folder? 

D Open the startup disk window. Make sure its size is optimized and 
it is displayed in By Name view. Select Print Window from the File 
menu to print a copy of the window. 

E With the Finder active, select Finder Shortcuts from the Help 
menu and use the feature to answer the following questions: 



How do you copy a file from one folder into another (instead 
of moving it)? 

2 How do you select more than one item in a window? 
3 When you are looking at the window of a nested folder, how 

do you open the window that holds the active folder? 

You can customize many aspects of the Macintosh environment using 
the Control Panels. To see which Control Panels are available on the 
Mac you are using, select Control Panels from the Apple menu. To 
open a specific Control Panel, simply double-click on it. Use the 
Control Panels to complete questions F through ]. 

F Open the Mouse Control Panel. Note the current settings before 
you change any of them. After experimenting with the settings, 
answer the following questions: 
1 What happens when you slow down the mouse tracking 

speed? 
2 Which double-dick speed do you prefer? Why? 

Change the settings back when you are done. 

G The Views menu lets you control what information is displayed 
in the list views (By Name, By Size, and By Date). List the options 
that are available for displaying information in list views. (If you 
were not able to answer question B because the disk information 
was not displayed in the status bar, click on the Show Disk Info 
In Header check box to select this option. You can now complete 
question B.) 

H You may have trouble because you are holding down the keys too 
long when you type (so multiple characters appear). How can the 
Keyboard Control Panel help you? 

Explore the Map Control Panel. What can you do with it? 

J Many user actions cause the Mac to beep. You probably hear the 
beep every time you turn on the Mac. Explain how to turn down 
the volume. 
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Glossary/Index 
8-N-1 The most common set of line settings. It means that 
data is sent in packets with 8 data bits, no parity, and 1 stop 
bit. 93 

( 88) Command key, 18 

486 microprocessor, 28 

A 
A:\>, as A-drive prompt, 42 

About This Macintosh command, 52 

access privileges Refers to each user's ability to read and 
write files from and to a remote computer. 90 

accounting software An application that has built-in 
features for keeping track of payroll, inventory, accounts 
payable and receivable, and other accounting systems. 76 

ADB port Apple Desktop Bus port. It is used to connect the 
primary Mac input devices, including the keyboard and the 
mouse. 35 

address bus The set of electronic pathways that the CPU 
uses to transmit the location of data. For example, to request 
data from memory, the CPU sends a number that indicates 
the location of the memory to the RAM chips through the 
address bus. The RAM chips send the data to the CPU 
through the data bus. 34 

Adobe Illustrator, 72 

AI (artificial intelligence) and expert systems, 77 

Alarm Clock, 52, 133 

Aldus FreeHand, 72 

Aldus PageMaker, 74 

algorithm A prescribed set of steps for solving a specific 
type of problem. 

alias A Desktop icon that looks like a file, but is actually a 
pointer to another file. Double-clicking on an alias opens the 
file that the alias refers to. If you put an alias for an appli­
cation icon in the Apple Menu Items folder, the name of the 
program appears in the Apple menu. Selecting the alias starts 
the program. 52 

America Online, 95 

analog Refers to a device that presents continuously variable 
data in a form that resembles the source of the data. For 
example, an analog watch gives data about the rotation of the 
earth with rotating hands. 

analytic graphics A chart that illustrates numeric data. 
The most common types are bar graphs, line graphs, and 
pie charts. 69 

animations, 54 

antivirus utility A program that detects viruses. It may also 
eradicate them. 57 

Apple Computer (Company), 6 

Apple File Exchange A program that enables a Super Drive 
to emulate a floppy drive for a DOS-based PC. With Apple 
File Exchange, you can copy files to and from a disk that was 
formatted (initialized) on a PC. 91 

Apple menu, 52-53, 59, 132-133 

AppleScript A system-level programming language that lets 
the user combine features from different applications and 
automate tedious procedures. 79, 112, 114 

Apple Standard /Extended Keyboards, 18 

AppleTalk Apple's proprietary networking system. 
Apple Talk networks are described as plug-and-play because 
every Mac comes with the necessary network hardware built 
in, and System 7 includes the necessary software. 88, 90 

Application Folder, 49 

application generator Software designed for creating 
special-purpose programs, commonly involving database 
programs. I 08 

Application menu, 133-134 

applications Application software. The task that application 
software helps you perform. 61 

combining, 78-79,81 

application software Programs that are used to get things 
done. Contrast with system software, which controls the 
computer's basic functions. Application software includes 
word processing, spreadsheet, database, graphics, and many 
other kinds of programs. 4 

ASCII The American Standard Code for Information 
Interchange. The most common system for translating bytes 
into alphanumeric characters. 27 

assembly language A programming language that uses 
symbols to represent common strings of machine language 
code. Assembly language is translated into machine language, 
using a program called an assembler. 104 

AT&T Bell Laboratories, 45, 105 
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ATM Automatic Teller Machine. A special-purpose 
computer that offers basic banking services to customers. 
Also, Adobe Type Manager, a font display technology by 
Adobe Systems. 13 

authoring tool A type of fourth-generation programming 
language designed for nonprogrammers. Authoring tools, 
such as HyperCard, are commonly used to create multimedia 
presentations and interactive programs. 109 

AutoCAD, 73 

B 
backing up Creating a second copy of data or software. 32 

backup A second copy of data or software, created in case 
the original is damaged or lost. 31 

backup utility A program that streamlines the process of 
backing up a hard disk. 56 

Backus, John, 104 

Balloon Help, 4 7, 134 

bandwidth The transmission capacity of a communication 
channel. Bandwidth is usually measured in bits or bytes per 
second. 88 

bar-code reader An input device used by many stores to 
read UPC symbols. 21 

BASIC A third-generation programming language originally 
developed for teaching programming, but now an important 
language in its own right. 104, 1 OS 

baud The number of signal changes per second. Baud is 
often used to describe modem speeds, although bits per 
second (bps) is the correct term. 92 

BBS See bulletin board service (BBS) 

Bernoulli removable hard disk, 32 

binary code Data represented with ones and zeros. The form 
in which data is processed by the computer. 5, 26 

bit A single unit of data, represented as a 1 or 0. Bit is a 
contraction of binary digi t. 27 

bitmap A graphic file that lists information about every 
pixel on the screen. 72, 73 

bits per second See bps. 

boxes See check box; dialog box; list box; text box 

bps Bits per second. A unit for measuring data transmission 
speeds. Modems and networks are compared in bps. 92 

Bricldin, Dan, 10 

bug A programming error or hardware malfunction. 

bulletin board service (BBS) An organization that lets 
computer users logon, via modem, and participate in 
electronic roundtable discussions or exchange messages with 
other users. 94-95 
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bus The data bus. The set of electronic pathways that 
transmit data to and from the CPU. 34 

bus topology A network configuration in which all of the 
computers are connected to a single wire that acts as a 
backbone for the network. 89 

button A screen element that initiates an action. The most 
common place for buttons is in dialog boxes. They are also 
found on HyperCard cards, where they often form links that 
let the user jump from one card to another. 50 

in dialog boxes, 50, 124 
in Hypercard, Ill 

byte A set of eight bits. One byte can represent a single letter, 
number, punctuation mark, or other symbol. 27 

c 
C++ An object-oriented derivative of the C language. 

C The most widely used third-generation programming 
language for developing microcomputer applications. 104 

cables for networking computers, 88 

Calculator, 53 

calendars, 76 

Cancel button, 124 

Caps Lock key, 18 

card A group of graphics, text and buttons that are 
presented on the screen together when using HyperCard. A 
set of cards comprise a HyperCard document, called a stack. 
77, 107, 111 

carpal tunnel syndrome (CTS) A type of repetitive-stress 
injury that results from holding the wrist in a flexed position 
for an extended period. The carpal tunnel is a sheath in the 
wrist that contains the nerves that go to the fingers. In CTS, 
the sheath is deformed and the nerves are pinched. 36 

CD-ROM Compact disc read-only memory. A storage 
technology in which data is held on a piece of textured foil 
that is sandwiched between clear plastic. The technology is 
identical to that used on audio compact discs (CDs). 33 

cell A location in a spreadsheet. The intersection of a row 
and a column. 68 

central processing unit (CPU) The part of a computer that 
performs the mathematical and logical manipulations of data 
that are referred to as processing. The CPU of a microcom­
puter consists of a single microprocessor. When speaking of 
microcomputers, the terms CPU, microprocessor, processor, 
and computer chip all mean the same thing. 28 

charts, 69 

check box A dialog box element that turns a software feature 
on and off. Clicking in a check box selects it; clicking again 
deselects it. 51, 124 

Chooserconunand,53 



ClarisWorks, 76 

class In object-oriented programming, a group of objects 
that share the same properties. 107 

cleaning the mouse, 19 

clicking Pressing and releasing the mouse button. 19, 119-120 

clip art Small, ready-made images that can be selected from 
a library of such images and pasted into other documents. 73 

Clipboard A Macintosh (also Windows) feature that allows 
the user to cut or copy data and paste it in a new location. 
The new location can be a different document, or even in a 
document created using a different program. 66, 78 

clock cycle A single tick of the system clock. 29 

clone See IBM -compatible. 

close box A Mac window element (upper left corner). Closes 
the folder or document when you click on it 48, 120, 125 

closing Closing a document, dialog box, or window from 
the screen and from memory. 

dialog boxes, 124 
documents, 65 
windows, 120 

coaxial cable A communication conduit sometimes used in 
networks. It consists of a central insulated wire, surrounded 
by a woven wire sleeve. 88 

COBOL A third-generation programming language, often 
used for business and accounting applications. 104, 1 OS 

code A general term for program instructions. 104 

code generators, 108 

Color control panel, 53 

color monitor An output device that displays images in 
color. Also called an RGB (Red, Green, Blue) monitor. 22 

Command (88) key, 18 

Command key combinations 
88-N for creating new items, 50 
88-S for saving, 18, 65 
88-X/CN for cut/copy/paste, 66 

command line interface A user interface in which the 
computer is controlled by commands that are typed at the 
keyboard. 42 

commands 
initiating by double-clicking, 120 
See also menus. 

communication device Hardware that is used to transmit 
data to and receive it from other computers. Includes 
modems, fax modems, and networking hardware. 4, 83 

communication software A program that is used in 
conjunction with a modem or fax modem to transmit or 
receive files through the phone lines. 10, 93, 100 

compact Macintosh Any Mac that conforms roughly to the 
design of the original Macintosh, with a 9" monitor built into 
the system unit. 7 

Compare modular Macintosh. 

compiler A program that translates a program written in a 
third-generation language into machine language before the 
program can be run. 104 

compressing files, 56-57 

CompuServe, 2, 95 

computer A collection of electronic machinery that accepts, 
processes, and presents data. 4 

advantages of, 1-3, 10-13, 14, IS 
ergonomic issues, 36, 39 
evolution and history of, 8-9, 14 
hardware and software, 4-5, 14 
how it processes data, 26-29, 38 
peripherals, 34-35, 39 
protecting, 37, 39 
turning on and off, 37, 39, 118, 135 
types of, 6-7, 14 

computer-aided design (CAD) software A program that lets 
the user create electronic models. 10, 73 

computer system A collection of hardware, the software 
that makes it run, the person (or persons) who uses the 
computer, and the data that the person wants to process. 4 

connect time charges Fees charged to users of bulletin board 
services and information services based on the time that the 
user was logged on to the service. 94 

context-sensitive help A help feature that automatically 
displays information that is relevant to the task that the user 
is trying to perform. 63 

control panel A dialog box that lets the user control a set of 
system parameters. The control panels are accessed by 
selecting Control Panels from the Apple menu. 53 

copying Creating a replica of a highlighted set of data and 
placing it in the Clipboard. 66 

between documents, 78 
items with Duplicate command, 52 

copyrighting (licensing) of software, 63 

CorelDRAW, 72 

CPU See central processing unit. 

Cray supercomputers, 8 

CRT monitor Cathode ray tube monitor. An output device 
that generates an image with an electron gun, which 
illuminates a grid of phosphor dots on a glass screen. 22 

cursor The point on the screen where text and numbers are 
being entered. In word processing programs for the Mac, the 
cursor is usually displayed as a blinking vertical line between 
characters. 18 
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cursor movement keys The four keyboard keys that are 
labeled with arrows and are used to move the cursor around 
the screen. 18 

cutting Removing a highlighted set of data and placing it in 
the Clipboard. 66 

D 
daisy-chaining Connecting peripherals or computers in 
sequence. 35 

daisy-chain topology A network configuration in which the 
computers are connected in sequence. 89 

data Raw facts. In a computer, data can refer to numbers, 
letters, images, or sounds. The computer processes data and 
turns it into useful information. 5, 26-29 

database An orderly collection of related information. 10, 70 

database management system (DBMS) Software for 
creating, sorting, querying, and creating reports on 
databases. 70 

databasesofihvare,ll, 70-71,80-81 
See also database management system (DBMS). 

data bits The number of bits in each set of data sent by a 
modem. 

data bus See bus. 

data encryption The process of encoding data that is sent 
through communication channels or stored on a network. 97 

data superhighway A nationwide web of communication 
channels that could provide a national infrastructure for data 
communication. 99 

dBASE, 108 

default button The dialog box button with a double border. 
Pressing the Return key performs the same action as clicking 
on the default button. 

Desktop The Mac's graphical background, which includes 
the Trash, the disk icons, and any open file folders. The 
Desktop is controlled by the Finder file, and Desktop and 
Finder are often used interchangeably. 46-4 7, 58 

desktop model A personal computer with a modular design 
and a system unit designed to sit horizontally on a desktop. 6 

desktop publishing (DTP) The creation of polished, 
professional-quality printed documents using a computer 
system. 10, 74-75, 81 

desktop publishing software A program that allows the user 
to create professional-quality documents, such as books, 
magazines, and newsletters. 10,74-75, 

devices, 17 

dialog box An on-screen window that requests additional 
information necessary to complete a command. 50-51, 
123-124 
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dictionaries on reference software, 76-77 

digital Refers to a device that represents data with binary 
numbers. 

Compare analog. 

dimmed menu options, 122 

discussion group In a BBS or information service, a group 
of users who are discussing a specific topic. 94 · 

disk crash A hard disk malfunction in which a read-write 
head makes contact with a disk surface (or pushes a foreign 
particle against the disk surface). The result is a damaged 
disk and lost data. 31 

disk defragmentation utility A program that reorganizes 
files on a disk so that the data for individual files are stored in 
contiguous sectors. The result of using this kind of utility is 
faster disk drive performance. 57 

diskettes See floppy disk. 

diskless workstation A networked computer that relies on 
the file server for its storage needs. A diskless workstation has 
no internal hard disk. 87 

documentation The books that come with a program when 
you buy it. 62 

document imaging The process of scanning and storing 
documents in a computer. 21 

documents Data files created using application software. 5 
active and inactive, 65 
closing, 65 
copying between, 78 
opening, 64-65 
saving, 65 
templates for, 64 

document window The type of window that is displayed 
when using application software on the Mac. It displays the 
contents of a data file. 64 

DOS Disk Operating System, the most common operating 
system used on PCs. Microsoft's first operating system, which 
came with the original IBM PC. 44 

dot-matrix printer A device that prints characters or images 
by pushing an inked ribbon against paper with a group of 
pins. Apple's Image Writer is a dot-matrix printer. 24 

double-clicking Positioning the mouse pointer, then 
pressing and releasing the mouse button twice in rapid 
succession. A technique often used as a shortcut for selecting 
an item and initiating a command, such as opening a file or 
completing a dialog box. 19, 120-121 

downloading Receiving a file from a remote computer. 

dragging Holding down the mouse button while moving the 
mouse. A technique used to move items on the screen or 
select a set of text characters. 19, 121 



draw program A type of graphics software that stores files as 
object graphics. 72-73 

drives, 30, 31 

DTP See desktop publishing (DTP). 

Duo and Duo Dock The Macintosh Duo is a subnotebook 
that can be slid into a docking station, called the Duo Dock, 
and act like a modular Macintosh, with a full-sized keyboard 
and monitor. 7 

E 
Easy Access control panel, 53 

Eckert, John, 8 

editing Changing an existing document. 64 

edition A set of data that has been published using System 
7's publish and subscribe feature. 79 

educational game A program designed to teach a topic or 
skill, but created with a game format to make learning more 
enjoyable or engaging. 12 

ejecting floppies, 47 

electronic mail See E-mail. 

Electronic Frontier Foundation (EFF) A Washington, D. C.­
based organization that gives legal aid to computer users 
whom the EFF believes are being unjustly prosecuted. The 
EFF also develops policies and conducts lobbying efforts on 
issues related to intellectual property law and privacy. 97 

ellipses( •.• ), 50, 123 

E-mail Electronic mail. A network messaging system that 
lets users leave notes for each other. 2, 10, 87 

Englehart, Doug, 19 

ENIAC Electronic Numerical Integrator and Calculator. The 
first electronic digital computer, developed by John Eckert 
and John Mauchly, and completed in 1946. Because of the 
ENIAC, 1946 is often considered the beginning of the 
computer age. 8 

erasable optical disk, 32 

erasing See Trash. 

ergonomics The study of the physical relationship between 
people and machines. Ergonomic is often used to refer to 
devices that are specially designed for comfort or physical 
safety. 36 

Ethernet A popular network protocol, developed by Xerox, 
Digital, and Intel. Ethernet networks use a bus topology. 89 

expansion board A printed circuit board that connects to 
the bus (via an expansion slot) and provides a port for a 
specific peripheral. 35 

expansion slot A connection on the motherboard where an 
expansion board can be plugged in. The bus connects the 
expansion slot to the processor. 35 

expert system A type of artificial intelligence program that 
can simulate human expertise and decision-making in a 
specific subject area. 77 

F 
fax modem A hardware device that includes both modem 
and fax capabilities. 92 

example of use of, 3 

fiber optic cable A communication conduit used in 
computer networks. The cable is made of glass fibers that 
transmit light. Fiber optic cable has the highest bandwidth of 
any communication channel. 88 

field In a database record, a place for data entry or display, 
such as a blank in a form. In HyperCard, an area on a card 
that contains text. 

in database record, 70 
in Hypercard, 111 

file compression utility A program that uses algorithms to 
make data files take up less storage space. 56-57 

FileMaker, 108 

File menu, 52, 59, 122 

files Named sets of data or program instructions. 5 
management of, 48-49 
viewing by name or by icon, 49 
viewing lists in directories, 42 

file server A computer (frequently a microcomputer) with a 
large hard disk that acts as the central storage device for a 
network. 86-87 

FlleShare The software that allows multiple Macs on an 
Apple Talk network to exchange data in a peer-to-peer 
relationship. 90 

file transfer The process of moving a file from one computer 
to another through a network or over telephone lines. 86 

find and replace See searching and replacing 

Findcommand,52, 123 

Finder The program that presents the Desktop and the rest 
of the Mac's GUI. The term is often used interchangeably 
with Desktop. 44, 135 

flat-file database A database composed of a single file, 
representing a single collection of data. 70-71 

flat-panel monitor A thin type of screen often used on 
notebook computers. The most common technology used is 
the liquid crystal display, or LCD. 22, 23 

floppy disk A plastic disk, coated with magnetic particles 
and encased in a plastic shell or envelope. The disk is referred 
to as a storage medium. Also called a floppy or diskette. 30 

ejecting, 4 7 
write-protecting, 62 
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floppy disk drive The storage device that accesses and writes 
data on a floppy disk. Also called a floppy drive. 30 

flowchart A diagram that uses a standard set of symbols to 
show the function of each part of the program. 106 

folders The basic organizational element of a hierarchical 
file system. A folder can contain files or other folders. PC 
users use the terms directory and subdirectory. 48, 58 

creating, 128-129 
moving, 121-122 
nested, 48-49, 130-131 
opening, 52 
viewing by icon, 121-122 
viewing by name, 129-130 

font A typeface. A set of text characters that have a similar 
look. Common fonts include Times, Courier, Geneva, and 
Helvetica. 57 

formatting 
cells in spreadsheets, 6~9 
word processing documents, 67 

formatting diskettes See initializing. 

form letters See mail merge. 

formula In a spreadsheet, a mathematical statement that 
figures a value based on other values in the spreadsheet. 68 

FORTRAN The first third-generation programming 
language, commonly used to create applications in 
mathematics, engineering, and science. 104, 105 

fourth-generation language A class of programming 
languages that tend to be both more intuitive than third­
generation languages and designed for a specific area of 
program development. They include code generators, 
application generators, authoring tools, scripting and macro 
languages, and query languages. 108, 114 

FoxPro, 108 

function keys The keyboard keys labeled Fl through F12 or 
PIS. Used primarily on PCs as a way to enter commands. 18 

G 
games, 11 

gigabyte About one billion bytes. Abbreviated GB. 27 

grammar checker A software feature that scans a text 
document and alerts the user to nonstandard syntax and 
incorrect grammar. 67 

graphical user interface ( GUI) A user interface in which the 
user controls the computer with the help of icons and pull­
down menus. A GUI (pronounced goo-ey) is normally used 
with a mouse. 42 

extending with menus and dialog boxes, 50-51 
and object-oriented programming, 107 

graphics Electronic images. 
with desktop publishing software, 75 
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graphics software An application designed for manipulating 
electronic images. 10, 72-73, 81 

gray-scale monitor Similar to a monochrome monitor, but 
capable of displaying the one color with varying levels of 
intensity. 22 

GUI See graphical user interface (GUI). 

H 
hacker A skilled programmer or computer expert. The term 
is often used to refer to a criminal hacker who uses computer 
skills to break into corporate or government computer 
systems using a computer and a modem. 96 

handshake A signal that two modems use to ensure that 
both are set up with the same line settings. 93 

hard disk A magnetic storage device that holds data on a set 
of metal platters coated with magnetic particles. 31 

removable, 32 

hardware The electronic machinery that makes up a 
computer. Each piece of hardware is called a device. 4, 18-41 

hardware requirements The computer equipment required 
to run a program. The hardware requirements, usually listed 
on the box in which the software is sold, include the platform 
and the memory and storage required. 62 

help, context-sensitive, 63 

Help menu, 47, 134-135 

hierarchical file system The system of nested folders and the 
files they contain on a disk. 48-49 

highlighting, 19, 66 

Hoff, Ted, 8 

host mode A user interface established by a communication 
program. When the computer in host mode answers a call, 
the caller sees a menu of options for different operations, 
including sending and receiving files. 93 

HyperCard 109, 110-111, 114 
card example, 107 

HyperCard Player The part of HyperCard that lets you open 
and use but not create HyperCard stacks. 77, 110 

hypermedia Programs that let users follow cross-references 
between all types of computerized data. 77 

HyperTaUk, 109, 111 

I 
IBM-compatible A microcomputer, made by a company 
other than IBM, that conforms to the same basic design, and 
can run the same software, as the IBM PC, IBM PC XT, or 
the IBM PC AT. Used interchangeably with clone. 6 



icons Small, on-screen pictures that represent files or 
programs. 

on menu bar, 46 
for startup disk, 119 

image editing software A special class of program designed 
for editing graphics by adding textures, colors, and a wide 
variety of photographic and artistic effects. 72 

indicator lights The lights, present on many keyboards, that 
inform the user of the keyboard's current settings. They 
include the Caps Lock, Num Lock, and Scroll Lock lights. 18 

infoglut The overabundance of information. 99 

information A meaningful set of data. Processed data. The 
terms data and information are often used interchangeably. 5 

information agent A program capable of roaming through 
online file systems, looking for specific kinds of information 
for the benefit of the user. Same as knowbot. 99 

information service A company that offers a wide range of 
online services, including discussion groups, E-mail, 
electronic conferences, shopping, and reference data. 95 

information systems department In a large company, the 
department that takes care of the computer system and 
creates programs for the benefit of other users. 84 

initializing Preparing a disk for storing data The process 
involves the creation of tracks and sectors on the disk. PC 
users refer to the same process as formatting the disk. 31 

inkjet printer An output device that prints images using jets 
that spray tiny drops of ink at a sheet of paper. 24 

input Data that is entered into a computer. The electronic 
process of data going from its source to the processor. 4 

input device Hardware that you use to get data into the 
computer. Includes keyboards, mice, trackballs, and 
scanners. 4, 18-21 

installing Copying a program from the floppy disks (or CD­
ROM discs) on which it came to the computer's main storage 
device, which is usually the internal hard disk. The 
installation process is often automated by an Install or Setup 
program, and it often involves decompressing the program 
files. 62-63 

integrated software A single piece of software that includes 
several applications, usually word processing, spreadsheet, 
and database applications, and sometimes also graphics and 
communications applications. Microsoft Works and 
ClarisWorks are integrated software. 76,81 

Intel The world's largest producer of microprocessors for 
microcomputers. Intel makes the CPUs for most IBM­
compatible PCs. 28 

Internet The largest network, connecting universities, 
businesses, and government agencies worldwide. 95 

interpreter A program that translates a program written in a 
third-generation language into executable code (machine 
language) while the program is running. Many versions of 
BASIC are interpreted, rather than compiled. 104 

K 
Kemeny, John, 1 OS 

keyboard Input device for typing numbers, letters, and 
other written symbols. 18 

easing use of, 53 
proper height for, 36 

Keyboard control panel, 53 

keyboard shortcut A keyboard combination that, when 
pressed, initiates a command. Most keyboard combinations 
include the Command (88) key. 50 

kilobyte 210 bytes, or 1,024 bytes. Abbreviated KB. 27 

knowbot See information agent. 

Kurtz, Thomas, 105 

L 
label A group of text characters in a worksheet cell. In a 
worksheet, a cell can contain a value, a label, or a formula. 68 

Labels control panel, 53 

LAN See local area network. 

laptop A small, portable microcomputer. Often used 
interchangeably with notebook, but sometimes considered 
larger than a notebook. 7 

laser printer An output device for creating high-quality 
printed images. It works much like a photocopier, using a 
laser to apply static charges to a rotating drum, which picks 
up toner and transfers the toner to paper. The toner is fused 
to the paper with heat. 25 

LCD monitor A flat-screen monitor that uses a liquid crystal 
display. Liquid crystal is transparent in its uncharged state, 
but becomes opaque when a current is applied to it. 23 

licensing of software, 63 

line settings Settings used to control a modem. 93 

list box A dialog box element that displays a list of options. 
To select an option, you click on it. 51, 124 

loading Starting a program. The process involves copying 
the code from storage into memory. 64 

local area network (LAN) A computer network that fits in a 
room, a single building, or several adjacent buildings. 86, 99 

Compare wide area network (WAN) 

LocalTalk The cabling system used in Apple Talk networks. 
LocalTalk cables are a type of twisted-pair wire. 88 

logging off (logoff) Disconnecting from a network. 94 
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logging on (logon) The process of connecting to a network. 
It usually includes typing an identification name or number 
and a password. Login means the same thing. 94 

logic structure One of three basic logical patterns used in 
procedural languages. The three logic structures are sequence 
structure, selection structure, and loop structure. 106 

loop structure One of the three logic structures. A sequence 
of program instructions is carried out repeatedly while, or 
until, a logical test is true. 106 

M 
machine language The programming language that the 
computer understands. Machine language consists of binary 
code, that is, ones and zeros. 104 

Macintosh computers 
compared to PCs, ~7 
turning on and off, 118, 135 
types of, 7 

macro A series of program commands that are initiated with 
a single command. Macro languages are considered fourth­
generation languages. 109 

Magic Cap, 99 

magnetic tape A popular storage medium for backing up 
hard disks. The tape is encased in a plastic shell, similar to a 
music cassette. 32 

magneto-optical disk A storage medium that holds data in 
crystals whose polarity can be read by a laser. It takes an 
electromagnet and a laser to write data to a magneto-optical 
disk, but a laser alone can read the data. 32 

mail merge The process of combining a source document 
and a data file to create versions of the document for each 
line of data in the data file. Mail merges are most often used 
with form letters and address files. Mail merge capability is a 
common feature of word processing software. 67 

mainframe A large-scale computer that can serve the 
processing needs of hundreds or even thousands of users 
simultaneously. 8, 10, 84-85 

Map control panel, 53 

Mauchly, John, 8 

megabyte 220 bytes, or about one million bytes. Abbreviated 
MB.27 

megahertz (MHz), 29 

memory An electronic storage area that holds active 
programs and data files that are currently loaded. 28-29 

virtual, 33 

Memory control panel, 53 

menu bar The area at the top of the Mac's screen that 
includes the names of the pull-down menus. 4~7, 118 

menus, 50,58-59, 122-124 
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microcomputer A small, general-purpose computer with its 
CPU contained on a single microprocessor. Compare with 
mainframe, minicomputer, and supercomputer. Microcom­
puter and personal computer are used interchangeably. 6, 85 

microphone, 20 

MicroPhone II, 93 

microprocessor A computer-on-a-chip. A set of circuitry, 
etched onto a small piece of silicon, and containing the main 
processing components (the CPU) of acomputer. 8, 28 

Microsoft Corporation, 44 

Microsoft Works, 76 

MIDI Musical Instrument Digital Interface. A standard 
system for input, processing, and output of sound, often 
used to link computers to electronic musical instruments. 20 

minicomputer A small-scale, multiuser computer, often 
about the size of a filing cabinet. 8 

MIS (management information system}, 84 

modem A contraction of the terms modulator and 
demodulator. A device that translates a digital signal from a 
computer into an audible signal that can be transmitted 
through a telephone line. A modem also translates the 
audible signal back into a digital signal. 92, 100 

examples of use of, 2 
See also fax modem. 

modifier keys The keyboard keys that are used in combi­
nation with other keys. On the Mac, the modifier keys are 
Shift, Option, Control, and Command (88). 18 

modular Macintosh Any nonportable Mac with a separate 
monitor and system unit. 7 

Compare compact Macintosh. 

monitor A screen that acts as an output device. 22-23 
proper placement of, 36 
setting colors or shades of gray, 53 

Monitors control panel, 53 

monochrome monitor An output device that displays 
images using only one color. 22 

MooV The format of a data file that can be played using the 
QuickTime system extension. 55 

motherboard The computer's main circuit board. The CPU, 
the RAM and ROM chips, the system clock, the bus, and the 
expansion slots are all mounted on the motherboard. 34 

Motorola The company that makes the CPUs used in 
Macintosh computers. 

mouse Input device for controlling an on-screen pointer. It 
is used for many input tasks, including entering commands, 
controlling the cursor, and manipulating graphics. 19 

easing use of, 53 
how to use, 19, 119-122 



Mouse control panel, 53 

mouse pointer, 46 

moving, windows, files or folders, 121-122, 128-129 

MS-DOS,44 

multimedia The use of text, graphics, animation, and 
full-motion video (that is, multiple media) to present 
information. 23, 59 

with QuickTime, 54-55 

multitasking The ability to run more than one application 
at a time. 45, 78-79 

MYCIN medical expert system, 77 

N 
naming, folders, 128 

nested Refers to a folder that is inside another folder. 48-49 
exploring, 130--131 

network A group of computers, connected through a 
communication channel, such as twisted-pair wire or 
electromagnetic waves. 10 

advantages, 85-87, 100 
disadvantages, 96-97,99, 100 
hardware for, 88-89, 100 
software for Macintosh, 90--91, 100 
See also local area network; wide area network 

network administrator An employee who manages access 
privileges in a centralized network. Peer-to-peer networks do 
not generally have network administrators. 90 

network server See file server. 

network version A program that is specifically designed to 
let multiple users on a network use the program simul­
taneously. The software license for a network version limits 
the number of machines in the network that are allowed to 
use the program. 63 

New Folder command, 52 

node A connection point on a network. Both terminals and 
computers are considered nodes. 89 

notebook A small, portable microcomputer, about the size 
of an 81/2 x 11" pad of paper. Notebooks have hinged, flat­
screen monitors, and weigh less than 10 pounds. 7 

NotePad, 53 

numeric keypad A group of number keys on many 
keyboards that make it easier to enter numbers. 18 

Num Lock key, 18 

0 
object In object-oriented programming, a combination of 
data and instructions that is treated as a single entity. 107 

object graphics A graphic file in which shapes are 
mathematically defined. For example, a line segment is 
stored as a line shape with specific end points. 73 

Compare bitmap. 

object linking and embedding (OLE} A Microsoft Windows 
feature similar to the publish and subscribe in System 7. 79 

object-oriented programming (OOP) An approach to 
programming that is radically different than structured 
programming. Objects, often representing screen elements, 
act in response to messages sent by the system or other 
objects. 107, 114 

OCR Optical character recognition. A software capability 
that lets the computer translate a bitmap image into text code 
that can then be edited with word processing software. 21 

OLE See object linking and embedding (OLE). 

online Refers to a computer that is linked, whether by 
modem or network communication channel, to a remote 
computer. A user is said to be online, for example, when he 
or she has logged onto a bulletin board service. 94, 100 

OOP See object-oriented programming (OOP). 

opening 
documents, 64-65 
windows or folders, 52, 120 

Open Scripting Architecture (OSA}, 112 

operating system The system software that must be loaded 
into memory before any other software is loaded. The 
operating system establishes an application interface, a user 
interface, and an interface between the CPU and the other 
hardware. 4, 41, 42-43, 58 

five competitors, 44-45, 58 
See also Desktop; System 7. 

Option key, 18 

OS/2 IBM's operating system for PCs. 45 

output Processed information in a form that's useful to the 
user. The electronic process of information going from the 
processor to an output device. 4 

output device Hardware that presents information to the 
user. Includes monitors, printers, and speakers. 4, 22-25 

p 
page layout with desktop publishing software, 75 

Page Setup command, 52 

paint program A type of graphics software that stores 
images as bitmaps. 72 

palette A small window of clickable software tools, similar to 
a toolbar, but able to be moved around on the screen. 64 

parallel port A port that transmits multiple bits 
simultaneously. The SCSI port is a type of parallel port. 35 

Compare serial port. 
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parity A method of checking for errors in communication. 
Even parity means there are an even number of ones (each 
bit is either a one or a zero) in each set of data. 93 

Pascal A highly-structured third-generation programming 
language originally developed to teach structured program­
ming. 104 

passwords, 96 

paste To insert a copy of the data that is in the Clipboard 
into the current document. 66 

PC An IBM or compatible microcomputer. A personal 
computer. 6 

PC Paintbrush, 72 

Peachtree Accounting, 76 

peer-to-peer network A network in which users have control 
over files on their hard disks and can control access to their 
own files without relying on a centralized file server. 90 

pen-based computer A computer that uses an electronic 
pen as an input device. Some pen-based computers are also 
called personal digital assistants. 9 

Performa Mac, 7 

peripheral Any hardware device outside the system unit. 34 

personal computer See microcomputer. 

personal digital assistant (PDA) A palmtop or similar 
device. A highly-portable, specialized microcomputer, often 
designed as an electronic address book, datebook, and memo 
pad. Some pen-based computers are also called PDAs. 7 

personal information managers Programs that emulate a 
traditional office tool (such as a calendar, addressbook, or 
memo pad) on a computer. 76 

PICf files, 79 

pixel A contraction of picture element. A single phosphor 
dot on a monochrome monitor, or a group of three dots (one 
red, one blue, one green) on a color monitor. 22, 37, 72 

platform The hardware and operating system. Most appli­
cation software requires a specific platform, such as a Mac 
running System 7. 61 

plotter A type of printer that draws an image with movable 
pens. Most often used to render CAD images. 25 

pointer, 46 

pointing Moving the mouse pointer to a specific place on 
the screen. 19, 119 

pop-up menu A dialog box element that is used just like a 
pull-down menu. The currently selected option in the pop­
up menu is displayed above it. 50-51 

port A plug or socket where a peripheral can be attached to 
the system unit. 34-35 

Power Book A notebook Mac. There are several models in 
the Power Book series. 7 
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presentation graphics A type of graphics application that 
focuses on capabilities for creating visual presentations. 73 

printer A device that presents output on paper. 4, 24-25 

print server A device (often a microcomputer) that controls 
the flow of data to the printers on a network. The network 
printers are connected directly to the print server. 87 

procedural language A programming language that forces 
the programmer to write according to a specific order of 
actions, built around the three basic logic structures. Most 
third-generation languages are procedural. 104 

processing device Hardware that performs mathematical 
and logical manipulations on electronic data. Includes 
memory and the central processing unit (CPU). 4, 26--29 

ProComm Plus, 93 

program A set of instructions that tells the computer how to 
perform a task or group of related tasks. Often synonymous 
with software. 4 

starting, 64 
switching, 134 

programming The process of creating software. 103, 104-116 

programming language A set of words or symbols that are 
used to write instructions that control a computer. 104-1 OS 

protecting your computer, 37 

protocol In computer communications, a set of rules for 
communicating data. Network protocols include AppleTalk, 
Ethernet, and Token Ring. File transfer protocols for 
modems include Xmodem, Zmodem, and Kermit. 88, 93 

pseudocode Programming code that does not adhere to the 
strict, syntactical guidelines of the programming language. 
The use of pseudocode is a technique that allows the pro­
grammer to concentrate on the logical structure of the 
program rather than the syntax. 106 

publish and subscribe A System 7 feature that lets the user 
create and maintain active links between documents, so that 
a change in one document will be reflected in another. 79 

pull-down menu A list of options that is accessed by 
pointing at the menu name with the mouse, holding down 
the mouse button, and dragging down to the desired option. 

Q 
(luark}OPress, 74 

query In a database, a listing of records that meet specific 
criteria. 70 

query language A fourth-generation programming language 
designed for writing database queries. The best known query 
language is SQL (which stands for Structured Query 
Language). 109 

(luickTime An extension to the Mac's system software that 
enables that computer to play video clips, animated graphics, 
and sound. 54--55,59 



quitting Exiting and clearing a program from memory. 65 

R 
radio button A dialog box element that lets the user choose 
one option from a small set of related options. 51, 124 

RAM Random access memory. A type of chip that holds 
electronic data as long as it is fed an electric current. RAM 
and memory are often used interchangeably. 28-29 

RAM disk A part of RAM that is treated as a fast storage 
device. Configuring part of RAM to be a RAM disk can help 
notebook computers conserve battery power. 33 

raster graphics, 72 

README files, 62 

read-write head The part of a disk or tape drive that uses 
electromagnets to read data from, and write it to, a disk. 30 

record In a database, a set of data about a specific person, 
thing, or event. 70 

reference software A program that emulates a traditional 
reference source (such as a dictionary, encyclopedia, or 
almanac) on a computer. 76-77 

refresh rate The number of times each second that the 
phosphor dots on a CRT monitor are illuminated by the 
electron gun. Refresh rates are measured in hertz (Hz), which 
means cycles per second. 23 

relational database A database in which multiple files can 
be related to each other, as long as each file shares at least one 
field with at least one other file. 71 

removable hard disk A storage medium similar to a 
standard hard disk, but removable from the computer. The 
case that holds the disk is called a hard disk cartridge. 32 

resolution In reference to a monitor, a measurement of the 
number of pixels per inch, given in dpi (dots per inch). Most 
Mac monitors display 72 dpi. Resolution can also refer to 
dot-matrix, inkjet, and laser printers (also in dpi). 23, 24 

Ritchie, Dennis, 1 OS 

robot A special-purpose computer that performs a physical 
task. 13 

ROM Read-only memory. A type of chip that stores data 
permanently. The computer can read from, but not write to, 
a ROM chip. ROM chips often contain basic information 
that the CPU needs during startup. 28-29 

root The folder that contains the first level of storage in the 
hierarchical file system on a disk. On the Mac, it's the folder 
you see when you open a disk icon. 48 

s 
Save As command The command that you use to give a new 
name and location to a document. 65 

Save command The command that you use to save a docu­
ment under its current name in its current location. 65 

saving Copying a file from memory to storage. 65 

scanner Input device capable of reading a printed image 
and generating an electronic file from it. 21 

Scrapbook, 53 

screen saver A program that turns the screen blank or 
displays moving images when no user-initiated change 
(input) has occurred for a specific amount of time. 37 

script A short series of instructions that are carried out 
when an object receives an instruction. 108-109 

scripting language A type of fourth-generation program­
ming language, typically comprised of plain-language words, 
and used to automate application, or system-level proce­
dures. 108 

scroll arrow A window element, found at the end of a scroll 
bar, that is used to move gradually through a folder or docu­
ment. You use a scroll arrow by clicking on it or by pointing 
and holding down the mouse button. 48, 125 

scroll bar A window element that lets you move through a 
document or an open folder, displaying data that was not 
originally visible. 48 

scroll box A window element within a scroll bar that shows 
the approximate position of the data that is currently visible 
in the window. You can move to any position in a document 
or folder by dragging the scroll box along the scroll bar. You 
can move up or down through the document or folder, one 
screen at a time, by clicking above or below the scroll box in 
the scroll bar. 48, 125 

Scroll Lock key, 18 

SCSI port Small Computer System Interface port (pro­
nounced scuzzy). A fast type of parallel port commonly used 
onMacs. 35 

searching and replacing Two similar features found in word 
processing programs, as well as some other types of software. 
With search (also called find), the computer locates occur­
rences of a specific set of characters. With replace, the com­
puter searches for a specific set of characters and replaces the 
set with another that the user has entered. 66 

security issues, 96-97 

selection structure One of the three logic structures. Data is 
subjected to a logical test. If it passes the test, one instruction 
is performed. Otherwise, a different instruction is performed. 
106 

semiconductor A material that conducts electricity in its 
charged state, but doesn't do so in its uncharged state. 26 

sequence structure The simplest logic structure. A linear 
progression of program instructions. 
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serial port A port that transmits data in sequence, one bit at 
a time. The Mac's ADB port is a type of serial port. 35 

Compare parallel port. 

Shift key, 18 

Shut Down command, 135 

SIMM Single In-line Memory Module. A printed circuit 
board that holds RAM chips. SIMMs can be plugged into 
special slots to increase a computer's memory. 28 

simulation software A program that uses the computer to 
re-create a situation or phenomenon. The best-known 
example is the flight simulator that trains pilots. 12 

site license A software license that permits an organization 
to install a program on a specific number of computers. A 
site license to use a program on, say, ten computers is 
generally less expensive than buying ten separate copies of 
the program. 63 

size box A window element, in the lower-right corner of 
every window, that lets you control the size of the window. 
To change the size, you drag the size box. 48, 125 

"sleep" mode, 29 

Smartcom II, 93 

Smart House, 11 

software Electronic instructions that control the computer. 
A set of instructions is called a program, but the two terms 
are often used interchangeably. 4 

installing, 62-63, 80 
shopping for, 62, 80 
upgrading, 63 

software license An agreement between a software company 
and a customer that permits the customer to install a piece of 
software on a specific number of computers. Most software 
licenses permit the program to be installed on only one 
machine. 63 

See also network version; site license. 

software piracy Any breach of the software license, whether 
by loading the program onto more machines than the license 
permits, or by giving away or receiving an unlicensed copy of 
the software. 63, 96 

Software Publishers Association (SPA) An organization of 
software developers whose activities include investigation 
and prosecution of software pirates. 63, 96 

sorting Rearranging the records of a database file according 
to the data in one of the fields. 70 

Sound control panel, 53 

sound input, via microphone, 20 

sound output, 23 

Special menu, 135 
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special-purpose computer A computer-sometimes just a 
microprocessor in an appliance or tool-designed for a 
specific type of task. 13 

speedissues,29,53 

spelling checker A software feature that looks up all the 
words in a document and compares them to those in a built­
in dictionary. When a word isn't found in the dictionary, the 
spelling checker alerts the user with a dialog box. Spelling 
checkers are very common in word processing and DTP 
programs, but are also found in other types of software. 67 

spreadsheet A piece of software designed for creating 
budgets, tracking expenses, developing business projections, 
and doing other tasks that involve manipulating sets of 
numbers. Also a formatted table of text and numbers; that is, 
the output generated by spreadsheet software, or the 
computerized version of a ledger. In this sense, spreadsheet 
and worksheet are synonymous. 10, 11,68--69,80 

SQL (Structured Query Language), 109 

stack A HyperCard document, consisting of a group of 
cards. Because HyperCard is an authoring tool, a stack can 
also be considered a program. 77 

starting programs, 64 

star topology A network configuration in which all of the 
computers are connected to a central hub or ring. 89 

startup disk The disk (usually a hard disk) that contains the 
operating system. A startup disk must be present for the Mac 
to begin operation. The icon for the startup disk is displayed 
in the upper-right corner of the Desktop. 47 

startup disk icon, 119 

status bar, 125 

stop bit A bit that signals the end of a set of data sent by a 
modem. 

storage device Hardware that holds data when it isn't being 
used by the processing devices. Strictly speaking, storage 
devices write to and read from storage media, so a floppy 
disk drive is a storage device and a floppy disk is a storage 
medium. Storage media include floppy disks, hard disks, 
CD-ROM disks, magnetic tape, and so on. 4, 30-33 

structured programming An approach to programming 
using third-generation languages that involves the use of top­
down design, in which a program is broken into subroutines 
or modules. Structured programming may also involve the 
use of flowcharts, pseudocode, and logic structures. 106 

styles with desktop publishing software, 75 

subnotebook The smallest class of general-purpose com­
puters. Subnotebooks look like notebook computers, but 
usually weigh less than five pounds. 7 

supercomputer An extremely powerful computer, usually 
designed for complex mathematical processing. 8 · 



SuperPaint, 72 

surge suppressor A set of electrical outlets connected to 
a circuit breaker. It protects electronic equipment from 
electrical surges and spikes. 3 7 

SyQuest removable hard disk, 32 

System 7 A recent version of the Mac's operating system. 44 

System The name of the Mac's operating system file. 42, 44 

system board See motherboard. 

system clock A quartz timing device used to synchronize 
processing operations. The speed of the system clock, which 
is the number of times the clock ticks each second, is mea­
sured in megahertz (MHz}, which stands for millions of 
cycles per second. 29 

System File The file that comprises the core of the Mac's 
operating system. It works in conjunction with the Finder 
program, which controls the user interface. 44 

System Folder The folder in the startup disk that contains 
the Mac's operating system. 44, 49 

system software The set of programs that runs the com­
puter, controlling its basic functions. System software 
includes the operating system, utilities, programming 
languages, and the startup routines contained in ROM. 4 

system unit The main case of a microcomputer. The system 
unit houses the CPU, memory, bus, ports, expansion slots, 
power supply, and usually the main storage devices, such as 
the hard disk and one or more floppy disk drives. 6 

T 
tax preparation software A program that automates, as 
much as possible, the preparation of standard tax forms. 77 

technical support A service offered by a software developer 
in which staff members answer customer questions over the 
phone. Also known as telephone support. 63 

telecommuting Refers to working at a location other than 
the office (usually at home or on the road) while staying in 
touch with the help of a modem. 98 

template A generic master document that is modified to 
create other documents. 64, 7 4 

terabyte About one trillion bytes. Abbreviated TB. 27 

terminal A keyboard and monitor used to access a multiuser 
computer, such as a mainframe. 8 

text 
editing and formatting, 66-67 
representing with ASCII, 27 

text box A dialog box element in which text can be entered. 
50, 124 

TEXT files, 79 

thesaurus A software feature that provides the user with 
synonyms and antonyms of selected words. 67 

third-generation language A machine-independent 
procedural language that requires a machine-specific 
interpreter or compiler. 105, 114 

thread In a discussion group, a series of messages that 
respond to one message or to other responses to that 
message. 94 

time-sharing Refers to a large-scale computer system in 
which many users can access programs and data simul­
taneously. 84 

tide bar A window element that displays the name of the 
open folder (for a Desktop window) or the name of the open 
document (for a document window). 48, 125 

Token Ring A network protocol developed by IBM. 89 

toolbar A screen feature of some software, consisting of 
buttons that give the user quick access to the most commonly 
used program commands. 64 

top-down design The central technique of structured 
programming, in which the overall task to be completed by 
the program is broken down into smaller, more manageable 
tasks, which are accomplished by modules or subroutines in 
the program. 106 

topology The pattern of connections between the nodes on 
a network. 89 

touch screen A monitor that can sense when the screen is 
touched and thereby accept input. 20 

tower model A personal computer with a modular design 
and a system unit designed to stand on end, usually on the 
floor. 6 

trackball Input device that offers the same functionality as 
a mouse. The pointer is controlled by a ball that rolls within 
its housing. Trackballs are very common on notebook com­
puters. 20 

transistor An electronic switch that can be on or off. 26 

Trash A temporary storage area for files that the user wants 
to delete. The first step of deleting a file is to drag it to the 
Trash. The second is to choose Empty Trash from the Special 
menu. Dragging a floppy disk icon to the Trash ejects the 
disk.47, 119,131-132 

turning your Macintosh on and off, 37, 39, 118, 135 

tutorial A program designed to teach a topic or skill. 12, 54 

twisted-pair wire A common communication channel used 
in networks. It consists of two insulated wires that are twisted 
around each other. Local Talk cables are a type of twisted-pair 
wires. 88 

typesetting with desktop publishing software, 75 
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u 
uninterruptible power supply An electrical connection with 
a built-in battery that supplies current for a short time if the 
regular supply of electricity is cut, as in a blackout, providing 
enough time to save work to a disk before power runs out. 37 

Unix An operating system, originally developed by AT&T's 
Bell Laboratories, but sold by many different companies. The 
most widely used operating system on workstations. 45 

upgrade A new version of a program, usually offering more 
features or other improvements over the previous version. 63 

uploading Sending a file to a remote computer. 

USENET,95 

user The person operating the computer. 5 

user-friendly, 5 

user group A group of users who meet and discuss a specific 
piece of hardware or software. Some user groups meet in 
person, while others meet electronically, through BBSs or 
information services. 94 

user interface The set of on-screen features that let the user 
control the computer. The most common types of user 
interface are the command-line interface and the graphical 
user interface (GUI). 42 

utility software A type of system software that enhances the 
operating system. Examples include backup programs, file 
compression utilities, and antivirus utilities. 56-57, 59 

v 
value A number in a spreadsheet. In a spreadsheet, a cell 
can contain a value, a label, or a formula. 68 

vector graphics See object graphics. 

Ventura Publisher, 7 4 

video with QuickTime, 54, 55 

Views control panel, 53 

virtual memory A part of the hard disk that is used like 
RAM. Setting aside disk storage space for virtual memory lets 
System 7 open more programs and documents than available 
RAM allows. 33 

virus A rogue program that can reproduce itself in other 
programs or on other disks. Some viruses are harmless, while 
others can destroy data. 57 

VisiCalc, 8, 10 

voice recognition A computer's ability to translate spoken 
words into text or to accept them as commands. 9, 20 

volatility of computer memory, 29, 30 

152 Danny Goodman's Computer Concepts: Using the Macintosh 

w 
WAN See wide area network (WAN). 

Wastebasket, 4 7 

wide area network (WAN) A group of smaller networks 
(LANs), connected across a broad geographical area. 86,99 

Compare local area network (LAN). 

window On the Desktop it is an area on the screen that 
displays the contents of a folder. In an application, a window 
displays the contents of a data file. 48 

closing, 120 
how to use, 48, 58, 125-127 
moving, 121-122 
on Desktop, 119 
opening, 120 

Wmdows A GUI, made by Microsoft and used to make 
DOS-based PCs more user-friendly. 44-45 

as GUI operating system, 42 

Wmdows NT Microsoft's powerhouse operating system, 
which competes with Unix and OS/2. 45 

wireless communication Refers to a network that uses 
electromagnetic waves as a communication channel. Data 
can be transferred using microwaves, infrared, visible light, 
and common radio frequencies. 88 

word processing The process of entering and formatting 
written documents on a computer. 10, 66-67, 80 

word processing software A program for entering and 
formatting documents. 10-12 

word processor A word processing program. A computer 
specifically designed for word processing. 

word wrap A word processing feature that automatically 
determines where each line of text should end. With word 
wrap, you don't have to (and shouldn't) press Return or 
Enter at the end of each line. 66 

workgroup computing Refers to the cooperative 
arrangement of a peer-to-peer network. 90 

worksheet A data file created using spreadsheet software. 
The word spreadsheet is often used to mean worksheet. 68 

workstation A computer designed for engineering or 
graphics work. 9 

write-protect To mechanically prevent a disk from being 
written to. 62 

z 
zoom box A window element, in the upper-right corner of 
every window, that changes the size of the window between 
the optimum size (as determined by the Finder) and the last 
size that was set with the size box. To use the zoom box, you 
click on it. 48, 125, 126 




